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Action Pack for Windows® 95 

Minimum System Requirements 
e A 100% Windows® 95-compatible computer « 8 MB RAM 

system (including 32-bit Windows? 95- e CD-ROM drive 

compatible drivers for CD-ROM drive, video e Windows® 95 operating sytem 

card, sound card and input devices) + Mouse 

+ 486/33 MHz Optional 

e VESA Local Bus or PCI video Joystick or Gamepad 
e 256-color SVGA (640 x 480) 

Before Inserting the CD 
We strongly recommend that you run the program under the following conditions: 

e Your color resolution in Windows® is set at 256 colors. 

e You have 8 MB of RAM. 

e You have 1 MB of hard drive space. 

To Start Activision’s Atari 2600 Action Pack 
for Windows® 95 

1. Insert the Action Pack CD into your CD-ROM drive. 

2. Wait a few moments for the Action Pack title screen to come up; then click on 
the button displaying the game you wish to play. 

3. Enjoy your blast to the past! 
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If the Action Pack title screen does not appear, try performing the following steps: 

1. Double-click on the My Computer icon on your desktop or right-click on the 
icon and choose the Open option. 

2. Select the Refresh option located in the View pull-down menu. 

3. Double-click on the Action Pack icon in the window or right-click on the icon 
and choose the AutoPlay option. 

4. After the Action Pack title screen appears, click on the Play button. 

If the AutoPlay feature does not function, please check the following: 

1. Make sure the CD is clean and properly placed in the CD-ROM drive. 

2. Your CD-ROM driver may not be optimized for use with Windows? 95. 
To verify this, perform the following steps: 

a. Open the Windows? 95 Control Panel folder and double-click on the 
System icon. 

b. Click on the Performance tab. 

If any of your hardware drivers are not fully optimized for use with 
Windows? 95, they will be listed here with an explanation of the 
exact problem and suggestions on how to fix it. 
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Title Screen Button Functions 

More... — Click this button to access the Technical Help, About Action Pack, 
About Activision, On-Line Registration and Uninstall Action Pack buttons. 

Exit- Click this button to close the title screen and exit Action Pack. 

Technical Help — Click this button to view the latest technical information that was 
not included in the online help files. 

About Action Pack - Click this button to view the credits. 

About Activision — Click this button to view information on how to contact Activision. 

On-Line Registration - Click this button to register your copy of Action Pack over 
the modem. The Registration screen will automatically appear upon launching 
Action Pack the first time. 

Uninstall Action Pack - Click this button to remove all Action Pack files from 
your computer. 

Less... — Click this button to return to the initial title screen. 
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How to Play the Games 
Look for information from the 15 original game manuals in the online Help files 
within each game! 

Click on the button displaying the game you wish to play and press the F1 key or 
from the Help menu, select the Contents option and browse through the original 
game designer's tips on How to Play, Scoring and Hints. Under Game History you'll 
find recent interviews with the original game designers — find out what inspired 
them to create these games and what they're doing now! 

Select the Commands option for Description of Shortcut Keys and Menu Options. 
And for a quick cheat-sheet of game commands, select Shortcut Keys. Have fun!!! 

Uninstalling Action Pack 

1. Click the More button on the Action Pack title screen. 

2. Click the Uninstall button. 

3. Click the OK button if you are sure you want to uninstall Action Pack. 

4. All of the Action Pack files are now completely removed from your hard drive. 
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Troubleshooting Tips 

PROBLEM 

AutoPlay does 
not function 

Video Problems 

Windows? 95 

SOLUTION 

1. Make sure the CD is clean and properly placed in the 
CD-ROM drive. 

2. Your CD-ROM driver may not be optimized for use with 
Windows? 95. To verify this, perform the following steps: 

a. Open the Windows? 95 Control Panel. 
b. Open the System program. 
c. Click on the Performance folder. 

If any of your hardware drivers are not fully optimized for use 
with Windows® 95, they will be listed here, along with an 
explanation of what the exact problem is, and suggestions on 
how to fix it. 

Action Pack requires a Super VGA (SVGA) display at a resolution 
of 640x480 with 256 colors. If you run at a lower or higher reso- 
lution than this, you may run into problems. 

If you experience video problems while using this program, 
you should first make sure you have the latest Windows® 95 dri- 
vers for your video card. The Windows® 95 drivers are found on 
the diskette that came with your video card. If you purchased 
your video card before Windows® 95 was made available, updat- 
ed drivers may be obtained in a variety of places. The dealer who 
sold you your hardware should have access to the most recent 
video drivers. Most video card manufacturers maintain a BBS 
containing the latest drivers for free downloading. Drivers are 
available on CompuServe, America Online, The Microsoft 
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PROBLEM 

Error Message 

Error Message 

SOLUTION 

Network and other popular online services. We have provided a 
list of video card manufacturers, containing Technical Support 
and BBS numbers, that can be accessed from the Technical Help 
button located on the title screen. Please make every effort to 
install the latest video drivers before calling Activision Customer 
Support. 

Your sound card/driver does not support high speed PCM wave- 
form changes. 

When Action Pack installs for the first time, it attempts to auto- 
matically determine the optimal sound configuration for your 
hardware setup. Depending on the processing speed of your 
CPU, and the particular sound card you use, Action Pack will 
allow you to choose one of two methods, Most Accurate or 
Fastest. Most Accurate is suggested when Action Pack thinks 
your system is fast enough to play the PCM sounds without any 
noticeable delays. Fastest is suggested when Action Pack thinks 
you might experience slow-downs and delays during gameplay. 

This program has performed an illegal operation and will be shut 
down. 

a. This error message may be caused by a video card that is con- 
figured to display more than 256 colors. This occurs with any 
video card that is set to display more than 256 colors. The dis- 
play should be reconfigured for 256 colors. Contact your video 
card manufacturer if your current driver is unable to do this. 
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PROBLEM SOLUTION 

b. On slower machines, this error is often caused by having 
your graphics hardware acceleration set too high. To change 
this setting, perform the following steps: 

. Open the Windows® 95 Control Panel. 

. Open the System program. 

. Click on the Performance folder. 

. Click on the Graphics button. 

. Lower the acceleration speed until Action Pack loads 
smoothly. 

orton — 

Partial Sound 1. Adjust the PCM and FM bars under A// Games in the 
Settings menu until a desired sound level is achieved. 

2. Make sure you are using the latest sound driver for your 
sound card. 

3. Some sound card manufacturers do not have Windows® 
drivers that take full advantage of all Windows® functions. 
Because of this, some drivers will not allow all of the sounds 
of the original games to be played. We experienced this 
particular problem with the Media Vision Pro Audio 
Spectrum and Gravis Ultrasound drivers for Windows® 

For additional troubleshooting information, press the More button 
on the title screen and then press the Technical Help button. 
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Action Pack for Windows? 3.1 

Minimum System Requirements 
« IBM PC or 100% compatible + MS-DOS*/PC-DOS” 6.0 or higher 

« 486/33 MHz or faster e Microsoft® Windows® 3.1 

+ 4 MB RAM e Mouse 

+ CD-ROM drive or 3.5" HD (1.44 MB) e Sound Blaster or 100% compatible sound card 

e Hard disk drive with 10 MB available Optional 
e 256-color SVGA (640 x 480) Joystick 

Before Installing 

« Close all other applications. 

« Do not install this program to a shared network copy of Windows? The program 
needs to make changes to the \WINDOWS\SYSTEM directory that are not 
possible under shared network versions. 

e Do not install this version of Action Pack if you are using Windows® NT or 
Windows® 95. While the program may function on these versions of Windows? 
you may experience problems. If you are using Windows® 95 we recommend you 
install Action Pack for Windows® 95. Please refer to page 1. 

e For proper installation and best performance make sure you are running 
Windows? in Enhanced Mode with at least a 10 MB permanent swapfile. 
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+ We do not recommend installing this program to a compressed drive. If possi- 
ble, install to a non-compressed drive and run the program from there. If you do 
need to install to a compressed drive, the disk space requirements listed above 
are 20 MB of free disk space rather than 10 MB. 

e Make sure that the video driver you are using supports 256 colors. 

To Install Action Pack from Windows? 3.1 

1. Open Microsoft Windows® as you normally do: type win at the DOS prompt, 
and press <ENTER>. 

2. Insert the 3.5" Action Pack disk #1 in the 3.5" HD (1.44 MB) -or- 
the Action Pack CD-ROM disc in the CD-ROM drive. 

3. Pull down the File menu in the Program Manager and select Run... 

4. Click on the Browse button. 

5. Select the disk drive where you inserted your Action Pack disk. For example, 
if the Action Pack disk is in drive A, click on the drive A icon in the lower right 
corner. 

6. Double-click SETUP.EXE, click the OK button in the Run dialog box, and follow 
the on-screen instructions to install Action Pack on your hard drive. 

When setup is complete, your Program Manager will display the fifteen Action Pack 
game icons in the Activision window. You can then double-click on any of the game 
icons and start to play. Have fun! 
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Speed Test 

This product uses the new WinG graphical libraries for Microsoft® Windows® 3.1. 
If you have never used a WinG product before, there are some steps you should be 
aware of. Once the program has installed successfully, a video speed test will play. 
DO NOT interrupt this test. This test will run for a few minutes and determine the 
fastest way to send video to your existing hardware. This test will only run one time, 
and will not run again unless you change the video driver or resolution, reinstall the 
program, or install the program again. 

How to Play the Games 
Look for information from the 15 original game manuals in the online Help files 
within each game! 

Double-click on the game you wish to play and pull down the Help menu. From the 
Help menu, select the Contents option, or press the F1 key, and browse through 
the original game designer's tips on How to Play, Scoring and Hints. Under Game 
History you'll find recent interviews with the game designers — find out what 
inspired them to create these games and what they’re doing now! 

Select the Commands option for Description of Shortcut Keys and Menu Options. 
And for a quick cheat-sheet of game commands, select Shortcut Keys. Have fun!!! 

You can also view these Help files by using File Manager and double-clicking on 
the appropriate .HLP file in the directory where you installed the games. 
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Troubleshooting Tips 

PROBLEM 

Game freezes 

Unable to play 
any game 

Windows? 3.1 

SOLUTION 

i 
2. 
3. 

4. 

Make sure your computer has at least 4 MB of RAM. 
Make sure you are using Windows? 3.1. 
Close all other Windows? applications while playing the 
Action Pack games. 
Mute the sound effects and music by clicking in the 
corresponding box under the A// Games section of the 
Settings menu. If this helps, see #5. 

. Update your Windows® sound drivers. If an updated driver 
does not correct this problem, you will have to mute the 
sound effects to play the games. 

. Make sure the game was properly installed according to the 
install instructions. 

. Make sure you are playing on an uncompressed drive. 
Doublespace and other drive compression utilities are not 
supported. 

. Please refer to the ACTPACK.WRI file for more information. 

You can access this file by double-clicking on the Action 
Pack Read Me icon in your Activision window. 



PROBLEM 

Game window 
and Help win- 
dow appear 
simultaneously 

No sound 

SOLUTION 

1. In this situation the game window appears, the Help win- 
dow appears, and then the game window overlays the Help 
window again. You will see a white screen and portions of 
the graphics that will redraw themselves as you move the 
cursor. Press Escape to stop the game and then exit the 
game. Close the Help window and restart the game. 
Pressing the F1 and F2 keys simultaneously may have 
caused this to occur. Be sure you press the function keys 
one ata time. 

. There must be a 100% Windows*-compatible sound card 
capable of playing sounds at 22 kHz in your computer. 
Check the specifications of your sound card to see if your 
card meets this requirement. 

. Make sure your speakers are plugged in correctly, turned 
on and the volume is turned up to an audible level. 

. Make sure you have the latest sound drivers for your 
sound card. 

. Make sure your Mute Sound Effects £ Music box is 
unchecked under the A// Games section of the Settings 
menu. 

. Adjust the PCM and FM bars under All Games in the 
Settings menu until the desired sound level is achieved. 
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PROBLEM 

Partial sound 

Game colors 
are faded in 
appearance 

Controls do 
not work 

Windows? 3.1 

SOLUTION 

i: 

2. 

3. 

Adjust the PCM and FM bars under A// Games in the 
Settings menu until a desired sound level is achieved. 
Make sure you are using the latest sound driver for your 
sound card. 
Some sound card manufacturers do not have Windows® 
drivers that take full advantage of all Windows® functions. 
Because of this, some drivers will not allow all of the sounds 
of the original games to be played. We experienced this 
particular problem with the Media Vision Pro Audio 
Spectrum and Gravis Ultrasound drivers for Windows® 

. Make sure you are using a video driver capable of displaying 
256 colors. 

. Some game colors may not appear exactly like the originals 
simply because of the conversion from the cartridge to the 
emulated version. Some colors had to be hand “tweaked” to 
match the original games, and a few colors could not be 
matched exactly. However, most of the games do closely 
resemble the originals in color. 

. Check under This Game in the Settings menu and make sure 
a Key Setup, Joystick or Mouse (Kaboom! only) is selected 
as the controller for each player. 

. When choosing Key Setup, make sure the correct buttons 
are selected under the A// Games section of the Settings 
menu. 



PROBLEM 

Joystick does 
not work 

Using the joy- 
stick calibration 
program in 
Windows® 

Game too slow 

SOLUTION 

de 
2, 

=å 

or wr 

Make sure it is securely plugged into the correct game card. 
Use the joystick calibration program to make sure your 
joystick is calibrated properly. NOTE: Make sure that the 
cross appears in the center of the black screen (or close 
to it) during the Test in the joystick utility. Otherwise, the 
joystick will not respond correctly. 

. Open the Main program group window in the Windows® 
Program Manager. 

. Double-click on Control Panel. 

. Double-click on Joystick. 

. Click on the Calibrate button. 

. Follow the on-screen instructions. 

. When the calibration screen disappears, choose the 
Test button. 

. The joystick is calibrated if the white cross is in the center 
of the black screen. If it is, click on the Done button. If not, 
click the Done button and go back to #4 above to 
re-calibrate the joystick. 

. When done with the joystick utility, click the OK button. 

. lf your computer has a turbo button, make sure it is ON 
(or set to the highest MHz possible). 

. Make sure you are running Action Pack on a 486/33 or 
higher system. Any 486/25 or lower system will not usually 
perform at a speed comparable to the original Atari 2600 
game speed. 
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PROBLEM 

Game too fast 

Windows? 3.1 

SOLUTION 

3. 

¡A 

Aaw 

Make sure your video driver is running in 640x480 256 
colors. A driver that supports a greater number of colors 
may actually slow down the games. 

. Make sure you are using the latest driver for your 
computer's video card. Older video drivers may not be 
compatible with WinG. Please refer to the ACTPACK.WRI 
file for more information regarding video drivers under 
WinG. You can access this file by double-clicking on the 
Action Pack Read Me icon in the Activision window. 

. Move the Animation slide bar to a faster FPS under This 
Game in the Settings menu. 

. Use the small window to run the games. The larger maxi- 
mized window runs a little slower than the small window. 

. Turn the sound effects off by clicking on the Mute Sound 
Effects & Music box in the All Games section of the 
Settings menu. 

If your computer has a turbo button, make sure it is 
turned OFF (or set to the lowest MHz possible). 

. Move the Animation slide bar to a smoother FPS under 
This Game in the Settings menu. 

. Use the maximized window to run the games. 

. Turn sounds on by making sure the Mute Sound Effects 
& Music box is unchecked in the All Games section of the 
Settings menu. 



- 

PROBLEM 

Cannot play 
two-player game 

Shots appear to 
go through the 
enemy 

SOLUTION 

1. Make sure the game you are playing has a two-player 
option in How to Play in the Help menu. 

2. Make sure you have used the F4 key to select the correct 
game number for a two-player game. NOTE: The game must 
be in progress in order for the F4 key to be used. 

3. Make sure there has been a controller type chosen for Player 
#2 under This Game in the Settings menu. 

4. Make sure a different controller has been selected for each 
player. The same controller cannot be used for both players. 

The Action Pack emulation is only able to detect a “collision” 
(i.e. a laser hitting a meteor) when it checks certain areas on the 
screen for such an occurrence. In order to keep the game speed 
close to the original games, the emulator has small gaps where 
it may not be checking for a collision while it processes 
graphics on the screen. Because of this, some shots may 
appear to miss the target by passing right through it. 

Windows® 3.1 



Action Pack for Macintosh* 

Minimum System Requirements 
e Macintosh? or 100% compatible e Hard disk drive with 6 MB free space 

e 68LC040-25MHz or available 
PowerPC 601-60 MHz processor e 640 x 480 - 256 color or gray-scale 

(Sound not supported on AV models) (8-bit) graphics 
Note: Powerbook 520c and 540c e 13" monitor or Powerbook 520c/540c 

compatibility ONLY Color LCD Display 
e 8 MB of RAM (need 4.1 MB available) * System 7.1 to 7.5 
e CD-ROM drive or 3.5" High Density Optional: Joystick or Gamepad 

(1.4 MB) floppy disk drive 

This Installation Guide assumes that you are familiar with common Macintosh® 
usage and basic mouse functions such as clicking, double-clicking, dragging and 
selecting. If needed, please refer to your Macintosh® manuals and the Macintosh® 
Basics provided by Apple Computer, Inc. 

Optimization Tips 
To install and run Action Pack optimally, perform these steps: 

1. Turn off File Sharing by going to the Control Panels folder (located under the 
Apple menu) and double-clicking on Sharing Setup. Under the File Sharing 
section, make sure File Sharing is OFF (the button should read Start). If it is 
not off, hit the Stop button to turn it off. 

Macintosh® 



4. 

5. 

. Turn off AppleTalk by going into the Chooser (located under the Apple menu) 
and hitting the Inactive button in the AppleTalk section. 

. Inthe Memory control panel (located under the Apple menu in the Control 
Panels folder), make sure Virtual Memory is OFF, Modern Memory Manager is 
ON and 32-Bit Addressing is ON (depending on the type of computer you have, 
not all of these options will be available). 

Turn off any unnecessary extensions. (For Mom, leave Sound Manager on!) 

Restart your computer so that any changes you made will take effect. 

Installing Action Pack on Your Macintosh? 
Turn off any virus detection software before installation. 

If you are installing the CD-ROM version: 

6. 

í 

1. Insert Activision’s Atari 2600 Action Pack disc into your CD-ROM drive. 

2. Double-click on the Action Pack CD-ROM icon. 

3. 

4 

5 

Double-click on the Action Pack Installer icon in the Action Pack window. 

. Click on the Activision install screen. 

. Drag the Action Pack icon onto your hard drive icon located on the right side of 
the installer window. 

Once installation is complete, click Quit to leave the installer. You may now eject 
the Action Pack CD-ROM disc from your CD-ROM drive. 

Look for the Action Pack folder on your hard drive. 
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If you are installing the 3.5" HD (1.4 MB) Floppy disk version: 

1. 

2. 

3. 

Insert Activision's Atari 2600 Action Pack 3.5" HD (1.4 MB) floppy Disk One 
into your disk drive. 

Double-click on the Action Pack Disk One floppy disk icon. 

Double-click on the Action Pack Installer icon in the Action Pack Disk One 
window. 

. Click on the Activision install screen. 

. Drag the Action Pack folder icon onto your hard drive icon located on the right 
side of the installer window. 

. When the installer prompts you for the disk “Action Pack Installer 2,’ remove 
Disk One and insert Disk Two into the disk drive. 

. Once installation is complete, click Quit to leave the installer. 

. Look for the Action Pack folder on your hard drive. 

How to Play the Games 

1. 

2. 

Macintosh® 

Open the Action Pack folder on your hard-drive and double-click on the icon for 
the game which you want to play. Have fun! 

If you want information on the games contained in Action Pack, you can find it 
in the 15 original game manuals in the online Help files within each game by 
pulling down the Help menu. From the Help menu, select the Contents option 
and browse through the original game designer’s tips on How to Play, Scoring 
and Hints. Under Game History, you'll find recent interviews with the game 
designers —find out what inspired them to create these games and what they’re 
doing now! 



3. Select the Commands option for Description of Shortcut Keys and Menu 
Options. And for a quick cheat-sheet of game commands, select Shortcut Keys. 
A list of these shortcut keys is also located at the end of this manual. (Action 
Pack also supports joystick control. Consult your joystick operation manual 
for proper calibration and use.) 

4. You can record your high scores by selecting Top Scores from the File menu. 
Once in the Top Scores Hall of Fame dialog box, enter your name and score 
or time. 

Please see the README file on your Action Pack CD-ROM 
or Disk Two for more updated information. 

Troubleshooting Tips 

PROBLEM SOLUTION 

Unable to eject | Try turning file sharing off. This is accomplished by following 
my CD-ROM disc | step 1 in the Optimization Tips section on page 16. 

The game speed | Use the Animation bar to slow down the pace of the game by 
is too fast raising the Frames/Second (towards Smoother) to a more 

comfortable level. It is located under the Settings menu in the 
All Games submenu. 

Macintosh? 



PROBLEM 

The game speed 
is too slow 

The computer 
says there is not 
enough memory 
available when 
I try to play the 
game 

Macintosh? 

SOLUTION 

Use the Animation bar by lowering the Frames/Second (towards 
Faster) to adjust the pace of the game to your preference. It is 
located under the Settings menu in the All Games submenu. 
If the gameplay is still not satisfactory, make sure you have 
performed all of the steps in the Optimization Tips section on 
page 16 of this guide. 

If the game speed is still too slow, try running your Macintosh? 
without extensions (however, this may disable Mom sounds). 
You can do this by restarting your computer and holding down 
the Shift key during start-up (it will say “Extensions Off”). Once 
you are done playing Action Pack, restart your computer (do not 
hold down the Shift key). Your Macintosh® will be back to 
“normal” and you will then be ready to run programs other than 
Action Pack. 

Make more memory available for Action Pack by performing 
one or both of the following steps: 

1. Close any other programs which are currently open 
(e.g., try quitting out of EHelpEngine). 

2. Turn off all extensions. See the previous problem for 
instructions. 
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PROBLEM 

Error message: 
“Nagging fea- 
ture could not 
be initialized...” 

The game 
pauses or is 
jerky during 

play 

The colors of the 
game seem to 
be incorrect 

Controls do not 
respond properly 

SOLUTION 

Makes sure the icon for the game you are trying to play is 
located in the Action Pack folder. Next, check that your Sound 
Manager extension is being loaded (System 7.1.x users only). 
If needed, you can get this extension from your local Apple 
dealer or commercial online service. 

First, check if you have other Action Pack games open. If you 
do, quit out of them (this will free up processor power for the 
game you are playing). Second, you may have set the Animation 
bar (located in the All Games submenu in the Settings menu) to 
a low Frames/Second value. Try moving the value higher; this 
should smooth out the play. Finally, if the problem still persists, 
you may need to turn File Sharing and Virtual Memory off. 
Follow the steps outlined in the Optimization Tips section on 
page 16. 

Make sure your Monitors control panel is set to 256 colors by 
going into the Control Panels folder (located under the Apple 
menu) and double-clicking on the Monitors control panel. 
Click on the number “256” 

Check the key assignments in the All Games submenu (under 
the Settings menu) and be sure that the proper keysets are 
assigned to the respective players. 

Macintosh? 



PROBLEM 

My shots appear 
to go through the 
enemy and/or 
the collision 
detection seems 
to be off 

When playing 
H.E.R.O., there 
are times when 
my player dies 
very quickly for 
no apparent 
reason 

When playing 
Kaboom!, the 
game goes into 
the background 
unexpectedly 

The sound is not 
working 

Macintosh? 

SOLUTION 

The Action Pack emulation is only able to detect a “collision” 
(e.g. when a laser hits a meteor) when it checks certain areas on 
the screen for such an occurrence. In order to keep the game 
speed close to the original games, the emulator has small gaps 
where it may not be checking for a collision when it processes 
graphics on the screen. Because of this, some shots may 
appear to miss the target by passing right through it— this 
problem will become more prevalent as you increase the speed 
of the game via the Animation bar. 

This problem occurs for the same reason as mentioned above. 
Make sure that the Animation bar is set to 60 Frames/Second. 
Go into the All Games submenu (under the Settings menu) and 
click on the left arrow of the Animation bar until the square is at 
the far left end of the bar and it reads 60 Frames/Second. 

This problem occurs if the mouse button is accidentally hit 
when the cursor is off of the game screen. When playing, 
be sure not to depress the mouse button outside of the play 
screen. 

First try cleaning out your ears! Then, make sure that the game 
sound is turned on by pressing 36- S. Volume can be adjusted 
in the Sound control panel. The Control Panels folder can be 
found in the Apple menu. 
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Customer Support in the US 
Before contacting customer support, please consult the Technical Help file. lt con- 
tains the answers to some of our most frequently asked questions and may quickly 
and easily provide a solution to your difficulty. If after reviewing the Technical Help 
file you are still experiencing problems, please feel free to contact us through any of 
the services listed. 

So that we can better help you, please be at your computer and have the following 
information ready: 

1. Complete product title 
2. Exact error message reported (if any) and a brief description of the problem 
3. Your computer's processor type and speed (e.g. 486/66, Pentium 90, 

PowerPC Mac) 
4. Video and sound card makes and models (e.g. Diamond Stealth 64 video, 

Sound Blaster 16 sound...) 

Online 
Services with Activision Forums, E-Mail and File Library Support 

e Microsoft Network: From any MSN window, pull down the Edit menu and select 
Go to then Other Location.... At the prompt, type Activision and click OK. 

e America Online: MEDIAJAKE or use keyword “Activision” to locate the Activision 
forum. 

« CompuServe: 76004,2122 or [GO GAMBPUB] 
e Activision BBS: (310) 479-1335 Up to 28,800 Baud; 

Settings: 8 Bits, No Parity, 1 Stop Bit (8, N, 1) 
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Online (...continued) 

Services with E-Mail Support 
e Prodigy: ACTI10B 

e GEnie: ACTIVISION 

Internet support@activision.com or http://www.activision.com 

For more information on how to use our listserver, please send e-mail to 
CSbulletins@listserv.activision.com with the word “help” in the subject line. If you 
are already familiar with listservers, send e-mail to the same address with the word 
“index” in the subject line of your message for a list of files available from this 
service. 

Fax (310) 479-7355, 24 hours a day 

Mail Activision, Customer Support, P.O. Box 67713, Los Angeles, CA 90067 

Phone Call our 24-hour voice-mail system for answers to our most frequently asked 
questions at (310) 479-5644. Or contact a customer support representative 
at the same number between the hours of 9:00 a.m. and 5:00 p.m. (Pacific 
Time) Monday through Friday, except holidays. 

Activision is a registered trademark of Activision, Inc. Atari 2600 is a trademark of Atari, Inc. 
Macintosh is a registered trademark of Apple Computer, Inc. Windows is a registered trademark of 

Microsoft Corporation. © 1995 Activision, Inc. All rights reserved. 



Customer Support in the UK € Australia 
For Technical Support: 

In the U.K., please call 0990 143 525. 

In Australia, please call (61) 2 869 0955. 

If you have any comments, questions or suggestions about Activision's Atari 2600 Action 
Pack, or any other Activision product, you can contact us in the UK on 0181 742 9400 
between the hours of 1:00 p.m. and 5:00 p.m. (UK time) Monday through Friday, with the 
exception of holidays, or contact a customer support representative through the following 
online services. 

Online 
Services with Activision Forums, E-Mail and File Library Support 

e Microsoft Network: From any MSN window, pull down the Edit menu and select 
Go to then Other Location.... Atthe prompt, type Activision and click OK. 

e CompuServe: 76004,2122 or [GO GAMBPUB] 
e Activision BBS: (310) 479-1335 Up to 28,800 Baud; 

Settings: 8 Bits, No Parity, 1 Stop Bit (8, N, 1) 

Internet support@activision.com or http://www.activision.com 

For more information on how to use our listserver, please send e-mail to 
CSbulletins@listserv.activision.com with the word “help” in the subject line. If you 
are already familiar with listservers, send e-mail to the same address with the word 
“index” in the subject line of your message for a list of files available from this 
service. 

For Technical and Customer Support for the rest of Europe 
please contact your local distributor. 
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ACTIVISION Limited 90-Day Warranty 

Activision warrants to the original consumer purchaser of this computer software product that the recording medium on which the software program is recorded 
will be free from defects in material and workmanship for 90 days from the date of purchase. If the recording medium is found defective within 90 days of original 
purchase, ACTIVISION agrees to replace, free of charge, any product discovered to be defective within such period upon receipt at its Factory Service Center of the 
product, postage paid, with proof of date of purchase, as long as the program is still being manufactured by ACTIVISION. In the event that the program is no longer 
available, ACTIVISION retains the right to substitute a similar product of equal or greater value. 

This warranty is limited to the recording medium containing the software program originally provided by ACTIVISION and is not applicable to normal wear and 
tear. This warranty shall not be applicable and shall be void if the defect has arisen through abuse, mistreatment, or neglect. Any implied warranties applicable to 
this product are limited to the 90-day period described above. 

To receive a replacement, you should enclose the original product disks only, in protective packaging accompanied by 

+ a brief statement describing the defect, 

e your name and return address, and 

e a photocopy of your dated sales receipt. 

Please see the special “RETURNS” information for further instructions. Any questions? Call ACTIVISION Customer Support at one of the numbers shown below. 

EXCEPT AS SET FORTH ABOVE, THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED, INCLUDING 

ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, AND NO OTHER REPRESENTATION OR CLAIMS OF ANY KIND SHALL BE 
BINDING ON OR OBLIGATE ACTIVISION. IN NO EVENT WILL ACTIVISION BE LIABLE FOR SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGE RESULTING 

FROM POSSESSION, USE, OR MALFUNCTION OF THIS PRODUCT, INCLUDING DAMAGE TO PROPERTY AND, TO THE EXTENT PERMITTED BY LAW, DAMAGES 

FOR PERSONAL INJURY, EVEN IF ACTIVISION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW LIMITATIONS ON 

HOW LONG AN IMPLIED WARRANTY LASTS AND/OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMI- 

TATIONS AND/OR EXCLUSION OR LIMITATION OF LIABILITY MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY 

HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE. 

After the warranty period, a defective Activision CD or floppy disk may be returned to Activision with a check or money order for $7 U.S. (AUD$12.00 for 
Australia, or £7.00 for Europe) currency per CD or floppy disk for replacement (must be within one year of purchase). 

RETURNS: 

Certified mail is recommended for returns. For best service, please be sure to— 

1. Send the original product disks only, in protective packaging. 

2. Enclose a photocopy of your dated sales receipt. 

3. Enclose your name and return address, typed or printed clearly, inside the package. 

4. Enclose a brief note describing the problem(s) you have encountered with the software with the name of the product and the brand and model name or 
model number of your computer. 

In the U.S. send to: In Europe send to: In Australia send to: 

WARRANTY REPLACEMENTS WARRANTY REPLACEMENTS. WARRANTY REPLACEMENTS 

ACTIVISION ACTIVISION ACTIVISION 
PO. Box 67713 Long Island House, 3A PO. Box 873 
Los Angeles, CA 90067 1/4 Warple Way Epping, NSW 2121 

USA London, W3 0RQ Australia 
(310) 479-5644 United Kingdom (61) 2 869 0955 

Disc Replacement: 0181 742 9400 

COPYRIGHT: 
The enclosed software product is copyrighted and all rights are reserved by Activision, Inc. It is published exclusively by Activision, Inc. The distribution of this prod- 
uct is intended for the use of the original purchaser only and for use only on the computer system specified. Lawful users of this program are hereby licensed only to 
read the program from its medium into memory of a computer solely for the purpose of executing the program. Copying (except for one backup copy on those sys- 
tems which provide for it), duplicating, selling, or otherwise distributing this product is a violation of the law. This manual and all other documentation contained herein 
are copyrighted and all rights reserved by Activision, Inc.. These documents may not, in whole or in part, be copied, photocopied, reproduced, translated, or reduced 
to any electronic medium or machine-readable form without prior consent, in writing, from Activision, Inc. Willful violations of the Copyright Law of the United States 
can result in civil damages of up to $50,000 in addition to actual damages, plus criminal penalties of up to one year imprisonment and/or a $10,000 fine. In addition, 

violations of the Copyright law of other jurisdictions may result in civil damages and, in certain circumstances, criminal penalties. 

© 1995 Activision, Inc. Printed in the U.S.A. 
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Activision's Atari 2600 Action Pack (All Platforms) Registration Card 

For better service, please take a few moments to fill out this card and return it. 

EEE II ETEA 

SC eo 
LEE Er SECC 

State or Province 

Zip Code Country Phone 

Internet Address 

Place of purchase: 

Player's age: OM F Purchaser's age: M F 

About your computer: (IBM Compatible O Macintosh Power Mac [O Other. 

Processor: [1386 [1486 [168030 [168040 O Pentium O PowerPC O Other Speed: MHz 

Memory: 02 MB 04MB (J8MB [JOver8MB Hard Drive Size: MB 

Disc Drive(s): O 5.25" 03.5" O CD-ROM drive Graphics: OVGA O Super VGA O Mac Color O Mac B/W 

Peripherals: (J Joystick (J Mouse Modem Speed: [12400 Baud [19600 C 14,400 O 28,800 O Other 

Operating System: (J DOS O Windows O Mac O Other 

Sound Card: O Ad Lib O Sound Blaster O Roland O Media Visio Other 

Preferred Game Type: O Action O Adventure O Role playing O Sports O Simulation O Education 

O Kids Ent. O Strategy O Other 

Video game machines in your home: [C Super Nintendo Entertainment System U] Sega Genesis 

Sega CD [O Atari Jaguar 0 3D0 [O Game Boy O Game Gear O Other 

How many computer games do you own? Game cartridges? 

3 

What magazines do you read? 

Children in household? Yes ONo Age(s) 

Where did you hear about our product? U] Store shelf ( Friend O Magazine Other 



Before Mailing-In the 
Registration Card: 

Be sure to write in the Activision address of your 

region on the front of the registration card. 

ACTIVISION. 

P.0. Box 67713 P.0. Box 873 

Los Angeles, CA 90067 Epping, NSW 2121 

U.S.A. Australia 

ACIIVISION. 



Rediscover 15 Original Atari 2600 

Video Games — Now on Your Computer! 
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Activision. Freeway, Pitfall! and River Raid are registered trademarks and Boxing. Chopper Command, 
Cosmic Commuter, Crackpots, Fishing Derby, Frostbite, Grand Prix, H.E.R.O., Kaboom!, Seaquest, 
Sky Jinks and Spider Fighter are trademarks of Activision, Inc. © 1995 Activision, Inc. Atari 2600 is a 

(el | ISION trademark of Atari Corporation. Microsoft and Windows are registered trademarks of Microsoft Corporation. 
o Macintosh is a registered trademark of Apple Computer, Inc. All rights reserved. 
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